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Eye On The World                      

_____________________________________________________ 
 
ColorMunki – Have your photos submitted for QuickPix, Members’ Night, or competitions not looked 
the way you expected?  The problem is probably a difference in how your computer and the club 
projector display colors and brightness.  You can fix this by calibrating your computer the same way 
our club calibrates our projector – with the ColorMunki.  Set up is simple and the calibration process 
only takes a few minutes.  Contact Jim Selby at jim1423@earthlink.net to reserve the ColorMunki. 

Puppy Portraits Help Shelter Pets Find New Homes 

Click HERE  for Slide Show 

Monday, Oct 16, 2017  NBC4 News 

RCC Member Alex Woodcock helps shelter pets find new homes by taking portraits 
of them. The photos of these furry creatures were taken at 
the Redlands Animal Shelter.  
 
"I love photographing animals," Woodcock said. "So it's a 
rewarding way to use my photography skills to make 
shelter pets look more appealing and adoptable."  
 
She says the photos help bring more people in to adopt 

animals that are waiting for good homes.  
 
The shelter is open from 10 a.m. to 5 p.m. Tuesday through Friday and 10 a.m. to 4 
p.m. Saturday. For more information, call 909-798-7644. 

 
Want to learn more about your hobby? 
Click the link below to go to B&H Learning Video Site: 
Click HERE 
 
 

PHOTOGRAM 
Monthly Newsletter of the Redlands Camera Club 

January 2018 
Photogram Editor - Wayne (Woody) Wood 

Deadline for entries is the 25th of every month 
 

Redlands Camera Club meets:  1st& 3rd Mondays, 7:00 pm 
First Presbyterian Church - 100 Cajon St - Redlands, CA 

Guests are always welcome 
 
 
 

http://www.redlandscameraclub.org/alex%20woodcock%20animals.htm�
https://www.bhphotovideo.com/c/promotion/13486/optic-2017.html?utm_medium=Email%201654964&utm_campaign=Promotion&utm_source=WeeklySpecials%20170916&utm_content=Retail&utm_term=optic-2017�


~ 2 ~ 
 

 

Programs for January 2018 

 
 
 

 

Programs 
Jim Hendon 

 
 
 
 

 
Jan 8: Rick Sforza: Photographing the San Bernardino and Las Vegas Shootings 

 
On Dec. 2, 2015, terrorists killed 14 people and injured 22 others in a mass shooting at 
government offices in San Bernardino. On Oct. 1, 2017, a lone shooter in a Las Vegas hotel 
room sprayed bullets over a concert crowd, killing 58 and injuring more than 500.  Rick Sforza, 
photo editor for the Southern California News Group, directed team coverage for several 
newspapers during and after these shocking events. He’ll share images and provide 

perspectives on how photojournalists approach the tough but necessary job of covering human tragedy 
for their readers. The News Group's breaking coverage of the San Bernardino attack was nominated for 
the Pulitzer prize in journalism. Sforza, who has led the Group's photo team since 2003, has been a 
frequent judge at Redlands Camera Club image competitions.   

 
Jan. 22 -- Selecting & Preparing Images for Competition with Frank Peele 

 
Leaving Long Beach - Photo by: Woody 

 
 
 
 
 
 
 

© Redlands Camera Club & Contributors The contents of the Photogram are copyrighted.  No material herein may be reproduced 
in any manner without the written permission of either the Editor or the material’s specific contributor. 
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On Dec. 2, 2015, terrors killed pd id 22 others a mass 
 

 shooting at government offices in San Bernardino. On Oct. 1, 2017, a 

lon Lightroom Classic CC Basic Course 
 
 

Classes:  Tuesdays   Feb 6, 13, 20          6:00 p.m. – 9:00 p.m. 
Presented by John Williams. 
This class will cover the basics of using Lightroom Classic to 
manage and enhance your digital images.  The course 
concentrates on the Library and Develop modules and covers 
topics such as managing and organizing your photos, culling 
your photos, easily finding your photos at a later date, 
collections, developing your images, including localized 
adjustments and sharing your photos.  A 300 plus page PDF 

document will be provided that covers all the topics you need for later reference.  
Students will be provided sample images and encouraged to bring their laptop 
computers to practice during the course.  Both beginners and seasoned users can 
benefit from this course.  Two additional instructors (Carl Detrow and Dave Ficke) 
will provide over-the-shoulder instruction. 
 
Tuition: $25.  No Textbook required. 
 
Requirements:  Highly recommend you subscribe to Adobe Creative Cloud 
(Photography plan – $9.99/mo.) and install the latest Lightroom program 
(Lightroom Classic CC).  Lightroom 6 users can also benefit from this course. 
Class sessions are held from 6:00 to 9:00 p.m. at Redlands First Presbyterian 
Church (100 Cajon St., Redlands, CA), in a classroom immediately adjacent to our 
main Redlands Camera Club meeting room. 
 
Objectives:  Create stunning Images and make your photos "pop."  Learn to 
manage your photos and to backup your photos/Lightroom. 
If you have any questions, call John at (909) 793-6861 or email: jhwr@earthlink.net  
Note:  Anyone can sign up for the course.  However, if you are not a Redlands 
Camera Club member, a membership fee will be included when you register ($25 + 
$35).  Maximum of twelve people, so enroll soon to reserve your spot. 
 
To register, click here.   
 
Registration for these classes is accomplished through the website 

mailto:jhwr@earthlink.net�
http://www.redlandscameraclub.org/education%20workshops.htm�


~ 4 ~ 
 

n a Las Vegas hotel room sprayed bulloverot crowd, 58 and injung 
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 Field Trips - Debra Dorothy 
 

 January Field-trip 
San Diego Safari Park 
Date: January 25th 
Location: 15500 San Pasqual Valley Rd, Escondido, CA 92027 
 
Time: 9:00-5:00 

 
Ticket Price is $54.00 
 
Parking fees: $15 per vehicle 
 
Since the parking for this event is so expensive I would suggest carpooling. 
 

We will meet at the Coco's 
Restaurant 1140 W Colton Ave, 
Redlands, CA 92374 at 7:30 am to 
carpool to event. Please email me 
ahead of time to let me know if 
you are attending and also if you 
want to carpool. 
Debbiedsd.dorothy@gmail.com 
 
If you have any questions you can 
call me at 909 633-2913 or email 
me at 
Debbiedsd.dorothy@gmail.com 
 
Hope you all can make it! 
 
Debbie 
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Prez Sez -  
Dave Ficke 
 

 It is my hope that you all had a great holiday in December 2017, and that 
2018 will be a healthy and fulfilling one for you all!   
 
We congratulate Debra for the excellent, informative workshop and field 
trip on bird photography early in December. Additionally, if Santa left a 
Sigma Sports 150-600 mm. lens under the tree, we might conclude that 
you were not naughty, but very nice last year.  We congratulate you! And if 
you didn’t get it, you probably need to do a better job of convincing your 
spouse this coming year.   

 
There are many reasons to look forward to 2018.  For one, there will not be a survey this 
year. Secondly, we look forward to John William’s Lightroom class the first three Tuesdays in 
February.  Next, we have added a landscape photo program with field trip, and a workshop on 
sports photography with additional field practice.  Members have shown interest in doing a 
Bristle Cone Pine field trip, and if we went on August 10-11-2018, we could tie it in with the 
Perseid meteor shower.  As a result of your responses on our 2017 survey, the spring 
competition will have “Category X” in Abstract Photography.  Not only are we listening to your 
suggestions, we are implementing them creatively and expeditiously; we are doing our best to 
provide workshops with fieldtrips and classes to help you become a better photographer.   
 
Redlands Camera Club operates all of our programs, workshops, field trips, etc. on a 
volunteer basis.  The club has accomplished this for over 122 years very successfully and 
with distinction.  I shared with you at our December competition awards banquet that two 
positions must be filled immediately in this New Year.  One, treasurer, does not require 
someone to be an experienced accountant or a CPA, but simply to be trustworthy, organized 
and efficient. The other good news is that you get to be on the RCC Board! But seriously, this 
very important position must be filled as soon as possible.  The second position is that of 
webmaster/Photogram publisher.  Woody, who has done a masterful job throughout is more 
than willing to help train the volunteer with the maintenance of the webpage and Photogram 
publication.  
 
The success of any organization is nurtured by the strength of its team.  RCC has been 
blessed with many members over more than one hundred years to help contribute to being a 
recognized and highly regarded photography club within California; that success is because 
of members like you.  As always, the beginning of a new year brings on new challenges as 
well as opportunities; with your continued support and amazing gift of volunteerism, 2018 is 
going to be an even better year for us in 2018!  
 
Dave 
Every Day is Earth Day 
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Membership - Stephanie Billings          

                                                                               NEWS FLASH! 

                                                 You may now join RCC or renew your membership via PayPal 
                                                     Just go to our WebSite at www.redlandscameraclub.com and 
                                                       click on the link 
 

Membership Renewal – We want to give a BIG SHOUT OUT to all 
our club members for renewing their 2017-18 membership.   Thanks 
everyone!! 
 
As of November 11, 2017 we have 120 members in good standing and 
our club just continues to grow. Since the beginning of our fiscal year 
we have received 17 new members.   
   All club members please introduce yourselves to our newest members 
and help direct them to members who can assist them with their 

photography needs.  
 
   If you are a new member we would like to get to know you better.  One way to do that is for 
you to give us a brief bio. We will post one in the Photogram each month.  Contact me by email 
(HeartandSoul4@yahoo.com) 
if you are interested in having your bio in the Photogram. 
 

Welcome Committee: I want to thank Jacque Sneddon for volunteering to be a part of 
the welcoming committee. We now have four committee members, Debbie Seibly, Carl 
Detrow, Jacque Sneddon and myself Stephanie Billings.  We are more then willing to help out 
with any questions club members may have. If we don’t have the answers we will direct you to 
the right person.  

 
Prospective new members please note: At Redlands Camera Club you’ll find a group of 
photo-enthusiasts with a wide range of interests, a ton of experience and a willingness to help 
you become a better photographer. Our regular club meetings offer stimulating programs, 
members’ nights and competitions; in addition, we offer field trips, workshops, classes and 
opportunities for mentoring and all of this for just $35.00! You can obtain an application form 
at one of our regular meetings or from our website by going to the club web site 
(www.redlandscameraclub.org), clicking on the “Downloads” tab and then clicking on 
“Membership Application” tab. Follow the instructions on the form and your all set!                                  
 
 
 
 

mailto:HeartandSoul4@yahoo.com�
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Competitions 
Russ Trozera 
 
 

                               2017 Winter Competition  

The Redlands Camera Club is proud to announce its Best of Show award for the 
2017 Winter Digital Competition titled “Touch Down” scoring 88 in the 
competition.  A hearty congratulation to Bruce Bonnett for a wonderful image of a 
Great White Egret flying over water capturing its reflection  in the water below.  
 
Our Spring Digital Competition will be on March 5, 2018. The judges during this 
competition will comment on each  image sharing their opinions  about the image 
along with a score.  This information gleaned from the judges is very educational  & 
valuable for improving your photography skills. I have often found I learn a lot 

more from the images that are less than perfect than the ones that are more perfect. The photographers 
are limited to one image during this competition.  
 
The club has also introduced a new category during the Spring  Competition that will rotate from one 
category to another each competition. We call this Category X. The subject of Category X  is  “Abstract” 
photography for the Spring Competition. Uploading photos will begin on Feb. 5, 2018 and end on Feb. 
19, 2018 at 11 PM  
 
Congratulations to all that participated in the 2017 Winter Digital Competition 
 
 
 
 
 
 
RCC 2017 
Winter Competition 
First Place Ribbons 
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Mentoring Session - Rick Strobaugh 
I will be holding another Mentoring session prior to the meeting on 
January 8. We will not be meeting the regular first Monday due to it 
being January 1. We will meet at the regular meeting lo  cation at 5:30 
PM for the Mentoring session. This is for any member who wishes to 
learn more about any subject related to photography or equipment 
with the goal to make you a better photographer. Contact me at 
rpdrunner@msn.com to let me know what you would like to have 
instruction on. This way, I am guaranteed to talk about what those 
attending want to discuss.  

 

 

 

 

 

 

 

 

                                                                                                 

 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
Photo by Bruce Bonnett  
Best Of Show  
2017 Winter Competition 
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Here’s What I Think!  
(Note: The article covers Lightroom topics.  The views expressed in this 

article are those of the author and do not necessarily reflect the views of 
Redlands Camera Club.)  

By John Williams 
Lightroom Classis CC and Lightroom CC: 

IMPORTANT:  Before installing Lightroom Classic CC, download and installed the latest Graphics driver from the manufacturer's 
website.  If you are experiencing problems (crashes  Library module shows a gray screen, Develop module show a black screen, or 
problems showing noise reduction/sharpening), then uncheck Use Graphic Processor box in the Edit>Preferences>Performance 
tab. 
Graphics processor acceleration requirements for windows: 

• AMD: Radeon GPU with DirectX 12 or OpenGL 3.3 support. 

• Intel: Skylake or newer GPU with DirectX 12 support. 

• NVIDIA: GPU with DirectX 12 or OpenGL 3.3 support. 

• OpenGL 3.3 and DirectX 10-capable video adapter for GPU-related functionality. 
You need a least 1 GB of Video RAM (VRAM). 2 GB of dedicated VRAM (4 GB recommended) for large, high-resolution 
monitors, such as 4K- and 5K-resolution monitors. 

Refer to the following Adobe link:  https://helpx.adobe.com/lightroom/kb/lightroom-gpu-faq.html for suggested system 
requirements and GPU recommendations. 
Personal note:  My AMD GPU didn't support some features in Lightroom Classic.  RCC member Woody Wood (computer guru) 
recommend the following GPU to replace my AMD GPU (purchased on Amazon for $140). 

EVGA GeForce GTX 1050 Ti GAMING, 4GB GDDR5, DX12 OSD Support (PXOC) Graphics Card 04G-P4-6251-KR 
Lightroom Classis CC and Lightroom CC: 

• Adobe Photoshop Lightroom Classic CC:  In Oct 2017, Adobe released Lightroom Classic CC.  This software replaces Lightroom 
2015.  Lightroom Classic, is a tool that’s based around photos being stored locally in folders on drives connected to your 
computer.  This is the 7th version of this product.  The core goal of this release is a commitment to improving 
performance across the workflow; however, Classis didn't get a long list of new features. 
NOTE — End of Perpetual Licenses:  Adobe will not offer a new standalone Lightroom software program 
(Lr 7).  However, they will continue to add new camera support to Lightroom 6 for a while. 

• Adobe Photoshop Lightroom CC (Version 1.0) —Cloud centric workflow:  Lightroom CC is a gateway to the Lightroom 
ecosystem that lives in the cloud.  If you take your multiple photos with a mobile phone and want to share/edit your photos 
on the go, then you should consider Lr CC.  With Lr CC, you store the full-resolution photos in the cloud, and this gives you 
access to your source photos from every device you own.  Lr CC does not have all the features of Lightroom Classic; however, 
Adobe is expected to add features in the future to make it similar to Lr Classic.  There isn't any Print, Map, Slideshow modules 
and other items such as Navigator panel, Tone Curve, Camera profiles, third-party plugins, clipping warnings, etc.  Advantages 
of this program are: 

1. You don't have to manage your files since your photos are uploaded to the cloud. 

2. You don't have to know anything about Catalogs. 

3. Since your photos are stored in the cloud, you can share your photos across multiple platforms. 

4. File backup is automatic. 

5. You edit the full-resolution originals, whereas Lr Classic you edit on a low resolution preview. 

6. You have access to Adobe Sensei which is an artificial intelligence and machine learning system to help you find your 
photos base on image content. 

Major disadvantage — cost:  You only get 20 GB of storage with the standard photographic plan ($10/month).  You will most 
likely need additional storage at $10/month for 1 TB.  Each additional TB of storage will be charged $10/month (you can buy 
additional storage in multiples of I TB, 2 TB, 5 TB or 10 TB).  Therefore, if you need 5 TB's of storage it would cost $50/month 
or $600/year. 

• Adobe Creative Cloud desktop app:  The latest versions of the Adobe applications as part of a Creative Cloud subscription 
now exclude the calendar year from the name when viewing the Creative Cloud application.  The "CC" version is the latest 

https://helpx.adobe.com/lightroom/kb/lightroom-gpu-faq.html�
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version, which will actually bear "2018" as the year portion of the full application name after you install the new version.  The 
"CC 2017" version is the prior version of the application. 

• Comparison charts: 

 

 
Creative Cloud Photography Plan: 

The Creative Cloud Photography Plan includes Lightroom CC, Lightroom Classic CC, Photoshop CC, 
Adobe Portfolio, Adobe Spark, and 20 GB of cloud storage for $9.99 per month. 

Performance (LR Classic): 
Independent testing shows Importing photos can be 45–85% faster and culling 15% faster depending on your 
computer.  This testing turned off the GPU (Graphic Processing Unit) acceleration in the 
Edit>Preferences>Performance tab. 

Importing: 

• Embedded & Sidecar Preview:  This method grabs the low-res JPEG thumbnails that are embedded in the camera files (the 
same ones you see on the back of your camera on the LCD screen).   

 
 In the Library module:  The embedded previews are used in the Library module until you edit your photo in the Develop 

module 

 Loupe view:  Photos using the JPEG previews will display an Embedded Preview button in the lower-right hand 
corner.  You can click on the Embedded Preview button to see the high resolution preview.  

 
 Grid view:  A new icon (double arrow) will appear in the upper left corner of the thumbnails indicating these 

previews are the camera JPEG (processed by the camera). 
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In the Grid view, if you click on one of the double arrow icons in the Film Strip (top left of thumbnail), the following 
dialog will appear to give you the ability to change to a standard-size preview (for all the photos in the folder or 
selected photos): 

 
 As soon as you begin to see your photos during the import process, you can immediately start your culling process. 

 Develop module:  When you launch the Develop Module, the Embedded Preview will be disabled and replaced by a 
Standard Preview. 

 Tim Gray, a well know Lightroom instructor recommends not using the Embedded & Sidecar option when importing.  He 
recommends to use the 1:1 preview option on import if you zoom in on many images (Note:  A 1:1 preview will be 
generated for any photo you zoom in on).  For most photographers, he recommends selecting the Standard preview 
option.  However, for quick culling, I recommend the Embedded Preview. 

 NOTE:  There’s a new preference (Edit> Preferences>General Tab) labeled Replace embedded previews 
with standard previews during idle time, which when checked, will automate the process of replacing 
embedded previews (it’s off by default). 

 

 A new File Type sort order has been added to the toolbar in the Import Dialog, so you can quickly select 
or deselect files by type. 

Catalogs:  The catalog format has been upgraded.  The catalog size will shrink slightly because some values are 
being compressed to improve performance.  The upgraded catalog cannot be opened in Lightroom CC 2015 or 
Lightroom 6.  Improvements have been made to speed up launch times of larger catalogs. 

• When you launch Lightroom Classic for the first time, it will create a new Catalog based on your old Catalog.  
This process will compress your metadata information to help speed up performance.  The new Catalog will 
generally have the same name as your old Catalog with the number 2 appended to the end (i.e., Lightroom 
Catalog-2.Ircat). 

• Note:  Your old Catalog will remain in the same location on your harddrive.  After using the Lightroom for 
awhile, you can safely delete your old Catalog. 

Library Module: 

• Standard, 1:1 Previews and Smart Previews are generated much faster (but only for Quad-Core or higher 
CPUs). 

• Regenerating thumbnails, standard, 1:1 or Smart Previews is now faster due to a change in the Camera Raw 
cached preview size. 
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• Standard Preview have been increased in size to match 4K monitors.  When you choose Edit>Catalog>File 
Handling and select Auto Standard Preview Size, the new size can be up to 3840-pixels (up from 2048-
pixels). 

• Smart Collections under the “Title” field can now be set to “Is empty” and “Isn’t empty”. 

• Lens Profile Correction criteria added to smart collection. 

• Remove Chromatic Aberration criteria added to smart collections. 

• Deleting a collection is now faster. 
Develop Module: 

• There’s a new Process Version (PV) included in this release, 
and they’ve also renamed the previous PVs.  The latest PV is 
called Version 4, and earlier versions have been renamed in 
descending order: Version 3 (2012), Version 2 (2010), and Version 
1 (2003).  Photos will have Version 4 applied by default on 
import, but photos from upgraded catalogs will retain their PV 
until you make new adjustment in Lr Classic.  
If you see a lighting bolt icon (figure to right) in the lower right of 
the Histogram panel, hover your cursor over the icon to reveal 
which Process Version was used to process the selected the photo 
(example to the right shows Process Version 3 was used on the 
selected photo). 
If you click on the Lightining icon, it will update the photo to PV 4.  You will get the following popup when you 
click the icon: 

 
• Auto Mask now respects image noise reduction settings to help reduce “speckling”.  Results may be different 

than previous versions, so only applies to Process Version 4. 

• Develop performance improvements include: 

1. Lightroom starts faster. 

2. Building 1:1 preview as part of the import process is faster. 

3. It’s now faster to switch from Library to Develop Module the first time after opening. 

4. Images load quicker in the Develop module when going from one image to the next. 

5. The grid will populate quicker when moving from one collection to another. 

6. Local adjustment brushes are more responsive. 

7. Spot healing brushing is smoother. 

8. Temporary color glitches when moving slider should be gone. 

9. Improved GPU support for smoother editing on high resolution screens. (Requires Mac OS 10.11+ or 
Windows 10.0.14393 or later in addition to a graphics card with more than 1GB VRAM.  Earlier OpenGL 
support is still available for older hardware/software.) 

10. Using brushes to draw a circular pattern now has less jagged edges. 
Range Masking for fine selection control: 
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• Range Masking allows you to make precise color or tone-selection for local adjustments (Adjustment Brush, 
Radial or Graduated Filters) to define a rough mask, and then refine 
your selection using new Range Masking options. 
The new Color Range Masking and Luminance Masking tools allow 
you to build complex masks for local adjustments.  This means you 
can now mask detailed areas, such as trees and make localized HSL-
type adjustments, which was previously impossible without editing 
in Photoshop. 
To use the Range Mask, you need to first add a Gradient/Radial or 
Adjustment Brush.  Then select either Color or Luminance from the 
Range Mask dropdown menu. 

• Color Range:  To use the Color Range Mask, first add a 
gradient/radial or brush mask, select Color from the Range Mask 
dropdown menu. 

 Select the Color Range Selector (eyedropper) and click on 
your chosen color in the photo you wish to adjust.  You can add 
up to 5 samples by holding down the Shift key to add those 
selected colors.  For greater accuracy, click and drag rectangles 
around the colors you want to adjust. 

 Adjust the Amount slider to narrow or broaden the range of selected colors.  If you hold down the Alt 
key, and move the Amount slider, it will display the mask as grayscale while moving the slider, so you can 
easily refine your selection.  You can also depress the letter O to see the Mask overlay (reddish color). 

 

               
• Luminance Range:  To use the Luminance Range, first Mask your area first (using a gradient/radial or 

brush mask).  Then select Luminance from the Range drop down menu. 

 Adjust the Luminance Range slider to set the endpoints of the selected luminance range.  Consider the 
Range as a black & white gradient with the left side being pure black and the right side pure white.  If 
you move the left Range slider inward, the darker areas will not be adjusted. 

 Then use the Smoothness (Feather) slider to adjust how smooth the falloff is at either end of the selected 
luminance range.  

 For both sliders, hold down the Alt key to display the mask as grayscale while moving the sliders, so 
you can easily see the selection (white areas). 
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Photo Merge:  Multiple merge operations are now added to a job queue behind the scenes to avoid impacting UI 

responsiveness. 
Export:  When exporting photos, you can now exclude the information about the edits made by selecting “All 

Except Camera Raw Info” in Export>Metadata section. 
Note:  To see the Camera Raw Info, open the photo in 
Photoshop and choose File>File Info. 

Sync:  Sync is now paused during import for better import 
speed.  It automatically resumes after Import is completed, 
or you can manually resume by clicking in the Identity 
Plate to show the Activity Center. 

Preferences:  Camera Raw minimum cache limit is now 5GB. 
Slideshow Module:  The framework used for video rendering 

and processing for slideshows and video has been upgraded, 
so you should no longer see green frames with videos from 
Apples Live Photos. 

Lightroom Classic CC v7.1 released in December has two new important updates: 

1. Basic panel Auto button:  The Auto button (located next to Tone in the Basic panel) now uses Adobe Sensei 
to intelligently apply adjustments based on a photo’s light and color characteristics.  It now uses advanced 
machine learning to automatically apply the best edits and automatically adjusts the Exposure, Contrast, 
Highlights, Shadows, Whites, Blacks, Saturation, and Vibrance sliders.  9 out of 10 times you will be very 
happy with the results. 

2. Removal of individual samples within color range masking:  Simply Option(Mac)/Alt(Win)–click the 
existing Color Range Selector   (eyedropper) that you want to remove. 

 
           Photo by: Kish Doyle 
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Club Calendar 
 
           Information that was available to the editor at the time of publication 
 
Jan 1. – No RCC Meeting  
Jan. 8 – How Photojournalists Cover Mass Shootings: Rick Sforza  
Jan 22 – Selecting & Preparing Images for Competition with Frank Peele 
Feb. 5 – Joshua Tree NP Ecologist Mike Vamstad on Wildlife Photo Ethics  
Feb.19 -- Landscape Photography & Field Trip with Rick Strobaugh 
New – Personal Lightroom Coaching with John Williams  
 
RCC Members: Unique opportunity to make a difference 
Frank Peele, Education/Workshops Chair 

This newly-established museum needs quality photography of items in its collection, and has asked RCC for 
support. This sounds like a win-win situation, both for the museum and for our members who want to develop 
skills in “product” photography. I envision a workshop to teach the fundamentals, and one or more shooting 
sessions to get into creating great images for the museum’s use. If you’re interested in being part of this service 
to the community, or just want to find out more about the opportunity, shoot me an email: 

Museum of Redlands 

educationworkshopsrcc@gmail.com  Thanks, Frank 
 
 
                Photo by: Woody 
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                 RCC Photo Blog 
 
Carl O’Day 
 
 

 

 Photo by Woody 

We are up to 70 users and almost 1,100 images on the RCC Photo Blog. If you do 
not already have an account,  
send an e-mail to 
signup@rccphotoblog.com and we will 
get you set up. The blog is a great place to 
get input on your images. Other Members’ 
images can help you find some inspiration 
(and perhaps some motivation). 
 
We are working on the image color issue 

for some images.  When images are submitted they are resized to fit different 
screens.  In this process, they are desaturated a bit.  We don’t know the cause of 
the problem yet, but are working on a solution. 
 
I got tired of sifting through photography sites and blogs trying to find useful learning 
material.  In response, I created pbdigest.com – a curated (sort of) collection of 
photography articles from over 100 photography blogs.  Given that this site helps me 
keep track of useful learning resources, I though club members may benefit too.  I 
would also be interested in any feedback you might have.  Thanks for taking a look and 
I hope the site is helpful to you. 
 
 
Film cameras and Lenses Needed  
 
A group of photo-enthusiasts at Riverside Community College needs FILM 
cameras and lenses to use in their studies. If you have such equipment 
you’re willing to donate to a worthy cause, please contact RCC member 
Constance St Jean and let her know what you have. Contact her by email 
at constancestjean@gmail.com     
 

http://www.pbdigest.com/�
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For Sale: New in Box 
Tascam DR-60D Digital Audio Recorder 

 
Want to greatly improve the audio quality of videos made with your 
DSLR, Mirrorless or other digital camera? Tascam, the professional 
division of Teac Audio, has your solution – the DR-60D 4-channel audio 
recorder. Built to mount under your camera either on or off a tripod, this 
recorder offers 2 professional balanced XLR or ¼” TRS mic inputs plus 
a 3.5 mm stereo mic input. Its many modes allow you to capture very 
high-quality sound, tailor the sound to your preferences, and use 
microphones of widely different types. The LCD screen is fully visible in 

any lighting condition (even direct sunlight), and complete controls put you in charge of your 
recordings. In addition to its potential for recording audio for video, its many capabilities make it an 
excellent choice for any high-quality audio recording – music, voice or you-name-it. Unit is in original 
box, has never been used, and comes with all included accessories. Sells on Amazon for                            
$179; priced for quick sale at $119.  
 
Frank Peele, 909.798.7999, or email to FrankPeele@verizon.net 
 
 
Approximately 30 brand new photo frames for sale. Sized from 8x12 on 
up to 18x24 and much larger. Contact Rick Strobaugh: 
rpdrunner@msn.com 
 

  

Selling my Canon 
zoom lens and I am 
asking $170.00. 
Contact me by phone 
or e-mail; 909 648-2584 
or    

carol.abidin@gmail.com 
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Redlands Camera Club    P.O. Box 7261 Redlands, CA 92375 
www.RedlandsCameraClub.com 

Officers (2017-2018) 
President:  Dave Ficke - Vice President/Programs:  Jim Hendon - Secretary:  Judith Sparhawk 

Treasurer:  Ann Kramer - Past President:  Carl Detrow -  

Chairs (2017-2018) 
 Competition:  Russ Trozera - Education/Workshops:  Frank Peele    Facebook/Event 

Photographer:  Bruce Woodcock - Field Trips:  Debra Dorothy      
Historian:  Bruce Bonnett - Hospitality/Events:  Lucy McGee - Librarian:  Mary Ann Ponder      

Membership:  Stephanie Billings - Mentor:  Rick Strobaugh - Photogram: Wayne (Woody) Wood        
Publicity: Alex Woodcock - S4C:  Deborah Seibly - Color Munki: Jim Selby 

Webmaster: Wayne (Woody) Wood - Welcome:  Stephanie Billings 
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